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About Measurements Database 
Measurements Database, designed for economical storing and easy managing of experimental 
data, provides convenient and fast way of searching and retrieving information. This software let 
one to get rid of a great amount of paper needed to keep information about the measurements as 
well as to avoid routine manipulation with computer files, folders, etc. 
Database consists of several tables with the automatically supported relationships between them. 
Each record in the  Observat table describes particular measurement and contains such 
experimental parameters as Sample Position, Start Time, Duration, etc, as well as array of the 
measured data. Several records from the Observat table are related to one record in the DataSets 
table (relationship "many-to-one"). This relationship reflects the experimental configuration 
when measurements of the same sample under the same external conditions are being performed 
in series. In this case, certain number of particular measurements should be collected into a 
group corresponding to the investigated object. Information, which is the same for every 



measurement within one group (like Guest, Sample, Date), is stored in the DataSets table as one 
record. Such relationship between the Observat table and the DataSet table, besides compressing 
of the information, allows to retrieve the whole set of measurements by selection only one record 
in the DataSet table. All parameters related to the DataSet and described all measurements within 
one group are stored in the Parameters table. This table is related  to the table DataSets by 
"many-to-one" relationship. 
 

 
 
The ExtParameters (External Parameters) table is used for storing External parameters such as 
Temperature, Concentration and so on. Table ExtParameters is related to the DataSets table by 
"many-to-one" relationship, so it is possible to link a number of External parameters to the 
particular DataSet. Additional reason for constructing ExtParameters and PNames tables is the 
possibility of visualization of the fit parameters as a function of a particular External parameter. 
If a series of measurements, for example, at Temperature = 10C, 20C, 30C, … was performed, 
one has to add a parameter 'Temperature' in the PNames table (if this parameter had not been 
entered before) and add a record in the ExtParameters table with the name 'Temperature' and 
Value = 10 and so on. The PNames table was designed in order to avoid mistakes while writing 
names of parameters. One should first enter the name of a new Parameter in PNames table than 
choose it from a drop-down list in the ExtParameters table. 
There are two auxiliary tables in the database: table Guests and table Samples. The first one 
contains information about person or organization who orders measurements, and the second one 
provides the detailed information regarding the explored sample. Both tables are related to the 
table DataSets by "one-to-many" relationship. Such a configuration makes possible to list all 
measurements performed for a particular person or a particular sample. At the other hand, all 
information about particular experiment (including personal information and detailed 
information about the sample) becomes available just by selecting one record in the DataSets 
table. 
RawData table is used for storing raw data (large binary file contains photon arrival times or 
time lags). Each record in the RawData table contains the link to the correspondent DataSet 
(automatically created during the import of raw data file). 



 
The main features of the database are:  

• fast storing the series of files in the Database;  
• importing the raw data;  
• simulation of the raw data with constant intensity and given autocorrelation function;  
• calculation of the statistical characteristics like autocorrelation, etc. from the raw data 

(with calculation of weight);   
• convenient representation of the stored data;  
• extensive possibilities for searching and filtering information;  
• build-in two-dimensional graphical pre-viewer of measured data;   
• form view and datasheet view of the tables;  
• possibility to create new sets of tables allowing to keep data in different folders or 

computers within the local network, etc, and easily switch between them at run time;   
• import and export of the experimental data and other information;  
• quick deleting all records from the selected table;  
• packing tables after deleting in order to reduce the size of the tables;  
• checking and repairing the tables;  
• generating and printing the reports on the base of the selected records. 

  
Database supports data integrity and validity. All information concerning the defined object is 
stored in one record in table. The mechanism of data integrity forbids deleting a record from one 
table which is linked to the records in the other tables. Data validity guarantees that values stored 
in the tables are always valid by the checking of the range and type of the entered data. Database 
is protected from the accidental changing or deleting of information by the default forbidding of 
editing.  
Database avoids data redundancy: each record has only one instance. It means that it is not 
required to enter information into the tables, if the same information is already stored in the 
database. User can just establish the relation between the entered and stored information. This 
feature is especially useful when one needs to update records in the database. The correction 
should be done only once at one point (where the changed information is stored) and then this 
update will take effect in all records which are related to the selected one. 
Database provides extensive possibilities for searching information. The fastest way how to find 
a record by a specific field is by typing first symbols of this field in a special window. Cursor 
moves to the record with the field, which contains symbols matching the typed ones. The 
possibility to sort any table by any field is also supported.  
User may also interactively create filter with complex conditions in order to decrease the 
selected number of records. 
 
Such operations as looking through the records, deleting records, editing information are 
provided by Database Navigator. 
 

Starting Measurements Database 
Starting Measurements Database can be started via  
� Start button on the Windows Task Bar: 
" Go to the Programs/FFS Data Processor/ and click the Measurements Database item; 
" Choose Run and specify the path to FFSDB.EXE; 
� Windows Explorer: 
" Locate and double-click the FFSDB.EXE file (if you have performed a default installation, 
this file is located in \Program Files\SSTC\FFS Data Processor\Bin). 
  
It is advisable to use Databases having administrative rights. 
FFS Data Processor can also operate at the user rights with properly defined write permissions 



and database options. There are four ways to do it: 
 
1. Set modify (not only write) permission to the directory (and all subdirectories) where program 
is installed (normally it is C:\Program Files\SSTC\FFS Data Processor). Set also write 
permission to the root C:\ directory (where file PDOXUSRS.NET is located).  
 
2. Open BDE Administrator (location path C:\Program Files\Common Files\Borland 
Shared\BDE\BDEADMIN.EXE), open the Configuration tab, then Drivers/Native/PARADOX, 
set the Net dir to any directory with write permissions (if you want to access data from the 
network, please share this directory for all users who can access database and additionally set 
System/INIT/LOCALSHARE to true) 
 
3. Set modify permission to the directory where program is installed. Open Options dialog 
(Tools/Options... menu item) from FFS Measurements Database and set network directory to a 
folder with write permissions. 
 
4. Open Options dialog (Tools/Options... menu item) from FFS Measurements Database and set 
network and private directory to folders with write permissions. Open Options dialog 
(Tools/Options... menu item) from FFS Analysis Database and set private directory to a folder 
with write permissions. 
Note. Private directories of both databases must be different.  
 
The last way is worst. Some database operations (packing tables, etc. ) may not work properly in 
some cases. 
 
Note: Users of Windows 7 can work with PARADOX databases without any limitations only if 
they are logged into using the Administrator account (not confuse with any other user account 
having Administrative rights). Use the way number 2 (preffered), 3 or 4 to work with Databases 
on Windows 7. There is one more solution of the problem: launch BDE Administrator with 
system administrator rights (using local menu command) just before opening Data Processor or 
any database.  
  
Main Window 
Main Window consist of the following components: 
" Menu 
" Toolbar 
" Files Group panel 
" Files panel 
" Parameters panel 
" Status Bar 
An example view of the Database Main Window  is given in the following figure: 
 
Menu and Toolbar provide quick way to invoke the commands of the application. 
Files Group panel represents information related to the whole set of files (DataSets table) and 
Files panel represents information for each file individually (Observat table). For more 
information about structure of the Database see About Measurements Database. 
Status bar, which is a horizontal area in Measurements Database below the Files Panel, 
provides information about the current state of application and any other contextual information. 
Alias of the current Database is displayed in the right part of the Status bar.  
 



 
  
Menu 
Main menu consists of following several popup items:   
Items  Description 

File  Contains menu commands for managing tables and importing/exporting data. 

Tables  Contains menu commands for opening tables. 

Find  Contains menu commands for finding information. 

Sort  Contains menu commands for sorting tables. 

Reports  Contains menu commands for previewing and printing automatically created 
reports. 

Tools  Use the commands of the Tools menu for RawData Processing, communicating 
with FFS Data Processor and performing some service database functions. 

View  Contains menu commands for managing the view of the opened tables. 

Help  Contains menu commands for accessing the online Help and information about the 
copyright.  

 
File menu 
Use commands of the File menu for managing tables and importing/exporting data.  
The File menu contains the following commands:   
Commands  Description 



New Tables 
 Opens New Database dialog box to create a new empty Database (set of tables) 
allowing to keep data in different folders or computers within the local network. 
One have to specify the Alias for this Database during this operation. 

Link Tables  Opens Link Tables dialog box for switching between Databases at run time.  

Import 
 Imports Files Group(s) with all supplementary information from the selected 
database to the current Database. Opens Import/Export Data form to select the 
Database and needed Files Group(s). 

Export 
 Exports Files Group(s) with all supplementary information from the current 
database to the selected Database. Opens Import/Export Data form to select the 
Database and needed Files Group(s).   

Exit  Finishes the work with Measurements Database.  
 
Tables menu 
Use the commands of the Tables menu for opening tables. 
The Tables menu contains the following commands:  
Commands  Description 

Guests  Opens Guests Form. 

Samples  Opens Samples Form. 

Files  Opens Files Form. 

Raw Data  Opens Raw Data form.  
 
Find menu 
Use the commands of the Find menu for finding information. 
The Find menu contains the following commands:  
Commands  Description 

Quick 
Search 

 Displays a search box for the corresponding field. If you want to find quickly the 
necessary record you should type the first few characters and press Enter. In this 
case the application will automatically select the first record that contains at the 
beginning the characters, which correspond to the typed ones. For the Numeric, 
Logical and Data/Time fields you should type the whole value for the 
correspondent field. To close the search box, press key Esc. 

Filter 
 Opens Filter dialog box that allows creating the filter that can be applied to the 
selected table. If this filter is applied, the only table records that correspond to the 
filter criteria will be displayed. 

Remove 
Filter  Removes Filter from the selected table.  

 
Sort menu 
Use the commands of the Sort menu for sorting tables. 
The Sort menu contains the following commands:  
Commands   Description 

Ascending   Sorts records of the table in ascending order  by the selected field. 

Descending   Sorts records of the table in descending order  by the selected field. 
 



Reports menu 
Use the commands of the Reports menu for setting the page setup, previewing and printing 
automatically created reports. 
The Reports menu contains the following commands:  
Commands  Description 

Page Setup  Opens Reports Options dialog box and display the  "Page setup" page. 

Files Group 
Report 

 Previews the Report. Opens Reports Options dialog box to set the filter on the 
DataSets table for selecting the records which will be included into the Report.  

 
Tools menu 
Use the commands of the Tools menu for communicating with FFS Data Processor and 
performing some service database functions. 
The Tools menu contains the following commands:   
Commands  Description 

Pack Table 
 Reduces size of a table by releasing any free space. Packing can be used for 
repairing the table, because the table is restructured during this operation. 
Opens Select Tables dialog box to select the table.   

Pack All Tables 
 Reduces size of all tables by releasing any free space. Packing can be used 
for repairing the tables, because the tables are restructured during this 
operation. 

Empty Table  Deletes all records from a table. Opens Select Tables dialog box to select 
the table.   

Empty All Tables  Deletes all records from all tables. 

Check Table  Checks a table. Opens Select Tables dialog box to select the table. 

Repair Table  Repairs a table. Packing tables can be used also for repairing the table. 
Opens Select Tables dialog box to select the table. 

Check and Repair 
Tables 

 Checks all tables and repairs them if they are corrupted. Packing tables can 
be used also for repairing the tables. 

Preview Graphs 

 Opens Preview Window for two-dimensional preview of  measured or 
calculated from raw data statistical characteristic as well as standard 
deviations and relative standard deviations of each point of the statistical 
characteristic. 

Options...  Opens Options Dialog box to set Borland Database Engine internal 
variables. 

Send Files to 
FFSDP  Sends selected files in the Files panel to the FFS Data Processor. 

Send Files Group 
to FFSDP  Sends all files of the current Files group to the FFS Data Processor. 

Commit Changes 
 Ends the default transaction and reconnects the Database. This command 
prevents you from loosing your changes you made after the abnormal 
program termination.  

  
View menu 
Use the commands of the View menu for managing the view of the opened tables. 
The View menu contains the following commands:  



Commands  Description 

As Form  Displays the table as form. 

As Datasheet  Displays the table as datasheet.  
  
Help menu 
Use commands of the Help menu to access the Help and get information about the copyright. 
The Help menu contains the following commands:  
Commands  Description 

Help Contents  Opens Help topic contents. 

About  Displays the copyright and version number for Measurements Database.  
  
  
Toolbar 
The Toolbar  is a row of buttons at the top of the Main window which represent application 
commands. Clicking one of the buttons is a quick alternative way to choose a command from the 
menu. Buttons on the toolbar are activated and deactivated according to the state of the 
application. 
 

 
 
To find out more about the functionality of any toolbar button, click this button on the figure 
above. 
The Toolbar has short Help Hints. Help Hint is the pop-up text that appears when the mouse 
pointer passes over a toolbar button.  
 

Button "View Table as Form"    
This button views the table as form.  

Button "View Table as Datasheet"    
This button views the table as datasheet.  
 
Button "Raw Data form"  
This button opens Raw Data form  

Button "Send files to FFSDP"    
This button sends selected files in the Files panel to the FFS Data Processor.  

Button "Send Files Group to FFSDP"    
This button sends all files of the current Files group to the FFS Data Processor.  

Button "Ascending Sort"    
This button sorts records of the table in ascending order by the selected field.  

Button "Descending Sort"    
This button sorts records of the table in descending order by the selected field.  

Button "Help"    
This button opens Help topic contents.  

Button "Quick Search"    
This button displays a search box for the selected field. If you want to find quickly the necessary 



record you should type the first few characters and press Enter. In this case the application will 
automatically select for you the first record that contains these characters at the beginning. For 
Numeric, Logical and Data/Time fields you should type the whole field value. To close the 
search box press key Esc.  
 

Button "Filter"    
This button opens Filter dialog box that allows creating the filter that can be applied to the 
selected table. If this filter is applied, the only table records that correspond to the filter criteria 
will be displayed.  
  
Database Navigator 
Such operations as moving from one record to another, deleting records and editing information 
are supported by the Database Navigator. 
 

 
To find out more about the functionality of any Navigator button, click this button on the figure 
above.  

Navigator button "First"    
This button moves cursor to the first record.  

Navigator button "Previous"    
This button moves cursor to the previous record.  

Navigator button "Next"    
This button moves cursor to the next record.  

Navigator button "Last"    
This button moves cursor to the last record.  

Navigator button "Insert"    
This button inserts new empty record.  

Navigator button "Delete"    
This button deletes the current record.  

Navigator button "Edit"   
This button switches the state of the table in edit mode. After updating information it is possible 
to save changes by pressing Post button or cancel changes by pressing Cancel button.  

Navigator button "Post"    
This button saves the current record.  

Navigator button "Cancel"    
This button cancels changes.  

Navigator button "Refresh"    
This button refreshes the information in the table. Valuable in multiuser application when several 
users work with the Database simultaneously.  
 
Files Group panel 
Local menu
 
Files Group panel represents information stored in the DataSets table. 
An example view of the Files Group panel is given below: 



 

 
 
Name of the DataSet, information about the Guest (person, who requests the measurements) and 
sample, date of measurements, as well as short description of the measurement, are displayed in 
this panel. It is possible to perform all manipulation with DataSets table with the help of 
Database Navigator which is placed in the bottom part of the Files Group panel. In this part you 
can see number of current record, number of all records and current state of the table. Button 
Copy allows you to copy all fields from the previous record with the related parameters. 
It is not necessary to type the name of Guest or name of sample each time when you create a new 
group of files. It is possible to choose it from the drop-down list. To add new Guest one should 
press arrow button in right part of Guest combo box. This button is enabled only in Edit or Insert 
mode. New information for the sample can be entered in the same way. 
DataSets table can be viewed as a form view or datasheet view. 
All actions under DataSets table are collected in the local menu.  
 
Button "Copy" 
This button copies all fields from the previous record to the current record as well as all related 
parameters from the Parameters and ExtParameters tables. It is enabled in Edit mode.  
 
Button "Insert new Guest" 
This button opens Guests Form to add new Guest. Name of the Guest will be pasted in Guest 
combobox after closing the form by pressing Insert button. It is enabled in Edit mode.  
 
Button "Insert new Sample" 
This button opens Samples form to add new Sample. Name of the Sample will be pasted in 
Sample combobox after closing the form by pressing Insert button. It is enabled in Edit mode. 
 
Local menu of the Files Group panel  
Items  Description 

Insert  Inserts a new empty record in the table. 

Delete  Deletes current record. 

Edit  Switches state of the table in edit mode. 

Post  Saves current record in the Database. 

Cancel  Cancels changes. 

Refresh  Refreshes the information in the table. Valuable in multi-user application when 
several users work with the Database simultaneously. 

Previous  Copies all fields from previous record to current record. 



copy 

Add 
new 
Guest 

 Opens Guests Form to add new Guest. Name of the Guest will be pasted in Guest 
Lookup after closing the form by pressing Insert Button. 

Add 
new 
Sample 

 Opens Samples Form to add new Sample. Name of the Sample will be pasted in 
Sample Lookup after closing the form by pressing Insert Button. 

Calc. 
Weight 
(repeat) 

 Calculates Weight Factors for repeated independent measurements with equal 
conditions (for all files related to the selected Files Group and viewed in the Files grid) 
as standard deviations of each point of characteristics. To select only needed files use 
the Filter. Number of selected files should be at least 6. Weight factors will be the 
same for all files. 

Clear 
Weight 

  Clears Weight Factors for all files related to the selected Files Group and viewed in 
the Files grid. To select only needed files use the Filter. 

Sort  Sorts the table. 

Find 
Record

 Allows to set the filter on the table and to search the information by typing the first 
few characters. 

Send 
Files 
Group to 
FFSDP 

 Sends all files from the Files Group to the FFS Data Processor. 

Generate 
Report  Generates the report based on the selected record. 

View  Allows to change the view of the table.  
 
Parameters panel 
This panel represents all parameters of the current DataSet (displayed in Files Group panel). 
 
An example view of the Parameters panel is given below: 

 
 
Parameters panel consist of the following pages: 
Experimental parameters page 
External parameters page  
 
Experimental parameters page 
Local menu
This page displays experimental parameters (parameters of equipment, etc.) of the current 
DataSet. The parameters are stored in the Parameters table. 



 
An example view of the Experimental parameters page is given bellow: 

 
 
All actions under Experimental parameters table are collected in the local menu.  
 
Local menu of the Experimental parameters page  
Items  Description 

Insert  Inserts a new empty record in the table. 

Delete  Deletes current record. 

Edit  Switches state of the table in edit mode. 

Post  Saves current record in the Database. 

Cancel  Cancels changes. 

Refresh  Refreshes the information in the table. Valuable in multi-user application when 
several users work with the Database simultaneously. 

Sort  Sorts the table. 

Find 
Record

 Allows to set the filter on the table and to search the information by typing the first 
few characters. 

Sort by 
Parameter  Sorts the DataSets table on the selected Parameter.  

 
External parameters page 
Local menu
This page displays external parameters of the current DataSet. The external parameters are stored 
in the External parameters table. 
External Parameters are used for storing such parameters as Temperature, Concentration and so 
on. Additional reason for using External Parameters is the possibility of visualization of the fit 
parameters as a function of a particular External parameter (for example, measurements were 
done at Temperature = 10C, 20C, 30C, …) . 
 
An example view of the External parameters page is given bellow: 



 
 
Field Name is the lookup field. It lookups the information from the PNames table. 
All actions under External parameters table are collected in the local menu.  
 
Local menu of the External parameters page  
Items  Description 

Insert  Inserts a new empty record in the table. 

Delete  Deletes current record. 

Edit  Switches state of the table in edit mode. 

Post  Saves current record in the Database. 

Cancel  Cancels changes. 

Refresh  Refreshes the information in the table. Valuable in multi-user application when several 
users work with the Database simultaneously. 

Sort  Sorts the table. 

Find 
Record

 Allows to set the filter on the table and to search the information by typing the first few 
characters. 

Add to 
Pick 
List 

 Allows to add new name of the parameter. Opens Parameters form.  

 
Sort by Parameter Menu 
Sorts the DataSets table  (displayed in Files Group panel) on the selected Parameter 
Items  Description 

Ascending  Sorts records in DataSets table in ascending order by the selected Parameter. 

Descending  Sorts records in DataSets table in descending order by the selected Parameter.  
  
Files Panel 
Local menu
Files panel represents all information about the measured data (Observat table) which are related 
to the current record in DataSets table (displayed in Files Group panel). 
An example view of the Files panel is given below: 
 



 
 
Each record in the  Observat table describes particular measurement and contains such 
experimental parameters as Sample Position, Start Time, Duration, etc, as well as array of the 
measured data. Several records from the table Observat are related to one record in the table 
DataSets (relationship "many-to-one"). This relationship reflects the experimental configuration 
when measurements of the same sample under the same external conditions are being performed 
in series. In this case, certain number of particular measurements should be collected into one 
global group corresponding to the investigated object. 
It is possible to perform all manipulation with Observat table with help of Database Navigator 
which is placed in the right part of the Files panel. In the bottom part of this panel you can see 
number of current record, number of all records and current state of the table.  

These buttons allow to import data from FFS and raw data files, export they to 
ASCII file, perform a preview of the data and see all files together without separating to series 
related to particular record in the DataSets table. To find out more about the functionality of any 
button, click this button on the figure on the left. 
Observation table in Files panel can be viewed only in datasheet view. 
All actions under Observat table are collected in the local menu. 
Button "Import File" 
This button opens the (depended of the import type) to import data from the FFS file (contains 
already calculated statistical characteristics) or from raw data file (binary file contains photon 
arrival time or time lags). It is necessary to choose the type of data from the "Import Type" 
combobox before importing. Date of measurement, description of the sample and all equipment 
parameters are imported automatically.  
Button "Export File" 
This button exports measured data to ASCII file. Opens the standard Save file dialog box to 
select the file.  
Combobox "Import Type" 
This combobox allows to choose the import type.  
Button "Preview" 
This button opens Preview Window for two-dimensional preview of measured or calculated from 
raw data statistical characteristic as well as standard deviations and relative standard deviations 
of each point of the statistical characteristic. The standard deviations (and relative standard 
deviations) can be viewed if they were calculated and stored (the field IsWeight in the Observat 
table indicates it).  



Button "All Files" 
This button opens Files Form. In this form all files are displayed together without separating 
them to series related to particular record in DataSets table. It allows to find needed files more 
quickly.  
  
Local menu of the Files panel  
Items  Description 

Import 
FFS 
File 

 Opens the (depended of the import type) to import data from the FFS file or from raw 
data file. It is necessary to choose the type of data from the "Import Type" combobox 
on the Files panel. Date of measurement, description of the sample and all equipment 
parameters are imported automatically. 

Delete  Deletes the selected record(s). 

Edit  Switches state of the table in edit mode. 

Post  Saves current record to the Database. 

Cancel  Cancels changes. 

Refresh  Refreshes the information in the table. Valuable in multi-user application when several 
users work with the Database simultaneously. 

Send 
Files to 
FFSDP 

 Sends selected file(s) in the Files panel to the FFS Data Processor. 

Export 
Data  Exports measured data to the ASCII file. 

Calc. 
Weight 

 Calculates Weight Factors assuming known statistics on the noise. It is enabled not for 
all types of characteristics because unknown noise statistics. 

Clear 
Weight   Clears Weight Factors. 

Sort  Sorts the table. 

Find 
Record

 Allows to set the filter on the table and to search the information by typing the first 
few characters. 

Preview 
 Opens Preview Window for two-dimensional preview of measured or calculated from 
raw data statistical characteristic as well as standard deviations and relative standard 
deviations of each point of the statistical characteristic.  

  
Guests form 
Local menu
This form is used for working with Guests table. It displays all information about person or 
organization who orders measurements. 
An example view of the Guests form is given in the following figure: 
 



 
 
To find out more about the functionality of any component, click this component in the figure. 
All actions under Guests table are collected in the local menu  
Main panel 
Represents all fields from Guests table. It can be viewed as a form view or datasheet view.  
Button "Select" 
This button closes the form and selects the first record in DataSets table (represents in Files 
Group panel in Main window) which correspond to the current Guest in this form.  
Button "Close" 
This button closes the Guests form.  
Button "Help" 
This button opens the help window that describes how to work with the form.  
 
Samples form 
Local menu
This form is used for working with Samples table. It displays all information about samples 
which were used in measurements. 
An example view of the Samples form is given in the following figure: 

 



 
To find out more about the functionality of any component, click this component in the figure. 
All actions under Samples table are collected in the local menu.  
Main panel 
Represents all fields from Samples table. It can be viewed as a form view or datasheet view.  
Button "Select" 
This button closes the form and selects the first record in DataSets table (represents in Files 
Group panel in Main window) which correspond to the current Sample in this form.  
Button "Close" 
This button closes the Samples form.  
  
Files form 
Local menu
This form is used for working with all records of the Observat table without separating to series 
related to a particular record in the DataSets table. 
An example view of the Files form is given in the following figure: 

 
 
To find out more about the functionality of any component, click this component in the figure. 
All actions under Observat table are collected in the local menu.  
Main panel 
Represents all fields from Observat table. It can be viewed as a form view or datasheet view.  
Button "Select" 
This button closes the form and selects this file in Files panel in Main window.  
Button "Close" 
This button closes the Observation files form.  
 
Current record.  
Total number of records.  
State of the table.  
 



Raw Data form 
Local menu
This form is used for working with Raw Data table. Each record in the Raw Data table is linked 
to the correspondent record in the DataSets table (which is automatically created during the 
import of raw data file). One can link many raw data files to one record in the Raw Data table 
when necessary. Especially it is useful when these raw data files represents a series of repetitions 
of the measurement with the same conditions. It reduces the number of records in the table and 
allows calculating of statistical characteristics from each repetition just by clicking one button. 
An example view of the Raw Data form is given in the following figure: 
 
To find out more about the functionality of any component, click this component in the figure. 
All actions under Raw Data table are collected in the local menu.  
 

 
 
Main panel 
Represents all fields from Raw Data table. It can be viewed as a form view or datasheet view.  
Button "Select" 
This button closes the form and selects the first record in DataSets table (represents in Files 
Group panel in Main window) which correspond to the current Raw Data record in this form.  
Button "Close" 
This button closes the Raw Data form.  

Button "Bursts counting"   
Opens RawDataBuilder.hlp>mainBursts counting window for counting of coincidence bursts as 
well as bursts in separate channels.  

Button "Export Raw Data to the ASCII file"   



This button exports raw data to ASCII file. Opens the standard Save file dialog box to select the 
file. Exports Red channel data to the first column, Blue channel data to the second one.  

Button "Raw Data Builder"   
Opens Raw data builder for the raw data processing.  

Button "Raw Data Simulator"   
Use to simulate the Raw Data time trace with constant intensity and given autocorrelation 
function (in form of pairwise stochastic point process).  
Opens Raw Data Simulator form.  
  
Forms menus 
Sort Menu 
Sorts the table. 
Items  Description 

Ascending  Sorts records of the table in ascending order by the selected field. 

Descending  Sorts records of the table in descending order by the selected field.  
 
Find Record Menu 
Allows to set the filter on the table and to search the information by typing the first few 
characters. 
Items  Description 

Quick Search 

 Displays a search box for the corresponding field. If you want to find quickly the 
necessary record you should type the first few characters and press Enter. In this 
case the application will automatically select the first record that contains at the 
beginning the characters, which matched the typed ones. For the Numeric, 
Logical and Data/Time fields you should type the whole value for the 
correspondent field. To close the search box, press key Esc. 

Filter 
 Opens Filter dialog box that allows creating the filter that can be applied to the 
selected table. If this filter is applied, the only table records that correspond to the 
filter criteria will be displayed. 

Remove 
Filter  Removes the filter from the table.  

 
View Menu 
Allows to change the view of the table. 
Items  Description 

View As Form  Displays the table as Form. 

View As Datasheet  Displays the table as Datasheet.  
 
Local menu of the form (Guests, Samples, All files, Raw Data) 
Items  Description 

Insert  Inserts a new empty record in the table. 

Delete  Deletes current record. 

Edit  Switches state of the table in edit mode. 



Post  Saves current record in the Database. 

Cancel  Cancels changes. 

Refresh  Refreshes the information in the table. Valuable in multi-user application when several 
users work with the Database simultaneously. 

Sort  Sorts the table. 

Find 
Record

 Allows to set the filter on the table and to search the information by typing the first few 
characters. 

View  Allows to change the view of the table. 

Select  Selects related record in the main form.  
  
Preview window 
This window is used to display stored in the current record of the Files panel the measured (or 
calculated from raw data) statistical characteristic as well as standard deviations and relative 
standard deviations of each point of the statistical characteristic in two-dimensional space. 
Standard deviations (and relative standard deviations) can be viewed if they were calculated and 
stored (the field IsWeight in the Observat table indicates it). 
Name of the file, name of the Files Group and type of stored data are displayed in the title of this 
window.  
An example view of the Preview window is given below: 
 

 
 
To find out more about the functionality of any component, click this component in the figure. 
Use local menu of 2D Chart for customizing the chart, export chart data to text and BMP files, 
save, apply and reset user defined settings. 
Use Navigator in the bottom part of this window to display characteristics of other files of 
current group.  
 
2D Chart 
This Chart displays stored in the current record of the Files panel the measured or calculated 
from raw data statistical characteristic as well as standard deviations and relative standard 



deviations of each point of the statistical characteristic in two-dimensional space. Dimensions of 
X and Y axis depends from the type of the characteristic.  
 
Button "Help" 
Opens the help window that describes how to work with Preview window.  
 
Button "Close" 
This button closes this window.  
 
Navigator 

 
 
This Navigator allows to scan measured data from the files belonging to the current Files Group.  
 

Button "Characteristic"   
Switches on/off the preview of the stored statistical characteristic.  
 

Button "Standard deviations"   
Switches on/off the preview of the stored standard deviations of each point of the statistical 
characteristic. 
This button is unavaiable if standard deviations have not been calculated. To calculate them 
check Weight cacl. check box  (it allows to calculate standard deviations of each point of the 
characteristic from the raw data) or use Calc. Weight local menu command of the DataSet panel 
of the main window (it allows to calculate standard deviations of each point of the characteristic 
from the set of characteristics measured (or calculated from the raw data) under the same 
conditions).  
 

Button "Relative standard deviations"   
Switches on/off the preview of the relative standard deviations of each point of the statistical 
characteristic.  
  
Parameters form 
Local menu
This form is used for working with PNames table. It displays the names of the external 
parameters. 
 
An example view of the Parameters form is given in the following figure: 

 
 
All actions under PNames table are collected in the local menu.  



 
Button "OK " 
Closes the form.  
 
Parameters grid 
Displays the name of the external parameter (PNames table).  
 
Local menu of the Parameters form  
Items  Description 

Insert  Inserts a new empty record in the table. 

Delete  Deletes current record. 

Edit  Switches state of the table in edit mode. 

Post  Saves current record in the Database. 

Cancel  Cancels changes. 

Refresh  Refreshes the information in the table. Valuable in multi-user application when several 
users work with the Database simultaneously. 

Sort  Sorts the table. 

Find 
Record

 Allows to set the filter on the table and to search the information by typing the first few 
characters.  

  
Import/Export Data form 
Use this form to copy the Files Group(s) with all supplementary information (files, parameters, 
linked raw data, etc.) from one database to another. 
An example view of the form is given below: 

 
 
To find out more about the functionality of any component, click this component in the figure.  
 



Button "Start" 
This button starts the import procedure.  
Button "Stop" 
This button stops the import procedure.  
Button "Close" 
Closes the dialog box without performing the action.  
Button "Help" 
This button opens the help window that describes how to work with Import/Export Data form.  
Source Databases 
This table is used to select the source database.  
Destination Databases 
This table is used to select the destination database.  
Source FileGroups table 
This table is used to select source Files Group(s). It is possible to select many File Groups.  
Destination FileGroups table 
This table represents FileGroups, stored in the Destination database.  
 
Local menu of the Source FileGroups table  
Items  Description 

Refresh  Refreshes the information in the table. Valuable in multi-user application when several 
users work with the Database simultaneously. 

Sort  Sorts the table. 

Find 
Record

 Allows to set the filter on the table and to search the information by typing the first few 
characters. 

Select 
all  Selects all records in the source FileGroups table.  

 
Local menu of the Destination FileGroups table 
Items  Description 

Refresh  Refreshes the information in the table. Valuable in multi-user application when several 
users work with the Database simultaneously. 

Sort  Sorts the table. 

Find 
Record

 Allows to set the filter on the table and to search the information by typing the first few 
characters.  

  
Report Options dialog box 
This dialog box is used for customizing the Report and selecting records which will be included 
into the Report. You can specify Page Setup settings to adjust the printed area. 
An example view of the dialog box is given below: 
 



 
To find out more about the functionality of any component, click this component in the figure.  
 
"Filter parameters" page 
This page is used  for selecting records which will be included into the Report. 
An example view of the Filter parameters page is given below: 
 

 
To find out more about the functionality of any component, click this component in the figure.  
 
Range of date panel 
This panel allows to specify the range of dates. You can use built-in calendar by clicking on the 
small button in right part of Editor.  
Button "Ok" 
This button closes the dialog box and starts creating the report.  
Button "Cancel" 
This button closes the dialog box without creating the report.  
Button "Filter" 
This button opens Filter dialog box that allows creating the filter that can be applied to the 
selected table. If this filter is applied, the only table records that correspond to the filter criteria 
are displayed.  
Button "Help" 
This button opens the help window that describes how to work with Reports Options dialog box.  
 
"Page Setup" page 
This page is used for setting paper size and paper margins for the report. 
An example view of the "Page Setup" page is given below: 
 



 
To find out more about the functionality of any component, click this component in the figure.  
 
Enter Height of your paper here.  
Enter Width of your paper here.  
Left Margin Enter the distance you want between the left edge of the page and the left edge of 
unindented lines.  
Rght Margin Enter the distance you want between the right edge of the page and the right end 
of the line with no right indent.  
Top Margin Enter the distance you want between the top of the page and the top of the first line 
of the page.  
Bottom Margin Enter the distance you want between the bottom of the page and the bottom of 
the last line of the page.  
 
Options dialog box 
Use this dialog box to set internal variables of Borland Database Engine. 
 
An example view of the dialog box is given below: 

 
 
To find out more about the functionality of any component, click this component in the figure.  
 
Network Directory edit 
Use Network Directory to specify the directory that contains the BDE network control file, 
PDOXUSRS.NET. 
This file governs the sharing of Paradox tables on network drives. All applications that share 
Paradox tables on a network directory must specify the same value for this property, and must 
have read, write, and create rights for the directory.  
Private Directory edit 
Use Private Directory to set the directory in which to store temporary table processing files for 
all database connections. 
For applications that run directly from a networked file server, the application should set 



PrivateDir to a user's local drive to improve performance and to prevent temporary files from 
being created on the server where they might conflict with temporary files created by other 
instances of the application.  
Button "Ok" 
Closes the dialog box and set variables.  
Button "Cancel" 
Closes the dialog box without setting variables.  
Button "Help" 
This button opens the help window that describes how to work with Options dialog box.  
Button "Browse" 
Opens standard Browse Directory dialog box.  
  
New Database dialog box 
Use this dialog box to create a new empty Database (set of tables) allowing to keep different data 
in different folders or even computers within the local network and easily switch between 
Databases at run time. You must specify the Alias for this Database in Alias edit. 
An alias is a name and a set of parameters that describe a database resource. BDE applications 
use aliases to connect with databases. 
If you want to use remote (writing local network) access to the Database you must set the 
Network Directory (Tools/Options... main menu item).  
An example view of the dialog box is given below: 

 
To find out more about the functionality of any component, click this component in the figure.  
 
Path edit 
Displays selected Directory.  
Button "Browse" 
Opens standard Browse Directory dialog box.  
Alias edit 
Is used to input new alias.  
Button "Ok" 
Closes the dialog box and performs the action.  
Button "Cancel" 
Closes the dialog box without performing the action.  
Button "Help" 
This button opens the help window that describes how to work with New Tables dialog box.  
Generate new Database Tables radio button 



If this radio button is checked, new empty database tables will be created in the specified path. 
The alias that is pointed to the Database will be created as well. 
Create new Alias only radio button 
If this radio button is checked, only alias that is pointed to the database tables located in the 
specified path will be created. New empty database tables will not be created. 
  
 Link Tables dialog box 
Use this dialog box to switch between Databases at run time. 
An example view of the dialog box is given below: 

 
To find out more about the functionality of any component, click this component in the figure.  
 
Button "Link" 
Closes the dialog box and performs the link with the selected tables.  
Button "Help" 
This button opens the help window that describes how to work with Link tables dialog box.  
Databases (Aliases) panel 
Represents alias, type and path of all registered databases at the local machine.  
Tables panel 
Represents name, date and size of the tables of the database.  
Button "Close" 
Closes the dialog box without performing the action.  
 
Select Table dialog box 
Use this dialog box to select the table. 
An example view of the dialog box is given below: 



 
To find out more about the functionality of any component, click this component in the figure.  
 
Button "Ok" 
Closes the dialog box and performs the action.  
Button "Help" 
This button opens the help window that describes how to work with Select table dialog box.  
  
Import Confocor files dialog box 
Use this dialog box to import data from the FFS file to the Measurements Database. 
An example view of the dialog box is given below: 
 

 
 
To find out more about the functionality of any component, click this component in the figure.  
 
Import Confocor 2 files dialog box 
FFS data page 
Use FFS file page of this dialog box to import data from the FFS file to the Measurements 
Database. The correspondent raw data can be also imported through Raw data file page of this 
dialog box (actually a link to the file is stored). One can link many raw data files to one record in 
the Raw Data table when necessary. Especially it is useful when these raw data files represents a 
series of repetitions of the measurement with the same conditions. It reduces the number of 
stored records and allows calculating of statistical characteristics in Raw Data Builder from each 



repetition just by clicking one button. 
Uncheck the Import FFS file check box if you want to import raw data file only.   
 
An example view of the dialog box is given below: 

 
 
To find out more about the functionality of any component, click this component in the figure.  

Button "Ok" 
This button closes the dialog box and starts importing the file to the Measurements Database.  
Button "Cancel" 
This button closes the dialog box without importing the file to the Measurements Database.  
Button "Help" 
This button opens the help window that describes how to work with the dialog box.  
"File name" edit 
This edit provides a space for you to type the name of the file you want to import to the 
Measurements Database.  
"Import FFS File" checkbox 
If this checkbox is checked, the FFS file will be imported to the Measurements Database.  
"File name" list 
This list shows files in the selected folder. To quickly select a file, click the file name in the list.  
"List files of type" combobox 
This combobox allows selecting the type of files to display.  
"Folders" box 
This box shows the drive and folder you have selected.  
"Drivers" combobox 
Use this combobox to select a drive from the Drive drop-down list.  
"Import All" checkbox 
If this checkbox is checked, all files with the same name (extension may be different) will be 



imported to the Measurements Database.  
"Cross-correlation" checkbox 
If this checkbox is checked, cross-correlation function will be imported to the Measurements 
Database.  
"Fluorescence intensity" checkbox 
If this checkbox is checked, fluorescence intensity for channel 1 (red) will be imported to the 
Measurements Database.  
"Fluorescence intensity" checkbox 
If this checkbox is checked, fluorescence intensity for channel 2 (blue) will be imported to the 
Measurements Database.  
"Photon counting histogram" checkbox 
If this checkbox is checked, photon counting histogram for channel 1 (red) will be imported to 
the Measurements Database.  
"Photon counting histogram" checkbox 
If this checkbox is checked, photon counting histogram for channel 2 (blue) will be imported to 
the Measurements Database.  
"Inter-event time histogram" checkbox 
If this checkbox is checked, inter-event time histogram for channel 1 (red) will be imported to 
the Measurements Database.  
"Inter-event time histogram" checkbox 
If this checkbox is checked, inter-event time histogram for channel 2 (blue) will be imported to 
the Measurements Database.  
"Autocorrelation" checkbox 
If this checkbox is checked, autocorrelation function for channel 1 (red) will be imported to the 
Measurements Database.  
"Autocorrelation" checkbox 
If this checkbox is checked, autocorrelation function for channel 2 (blue) will be imported to the 
Measurements Database.  
Description 
Allows to describe the imported raw data file.  
 
Raw data page 
An example view of the dialog box is given below: 



 
To find out more about the functionality of any component, click this component in the figure. 
 
"Start from this page next time" checkbox 
If this checkbox is checked, next time the Raw Data File page will be shown at the beginning.  
"Import Raw Data File" checkbox 
If this checkbox is checked, the raw data file will be imported to the Measurements Database.  
  
Import ISS ALBA files dialog box 
FFS data page 
Use FFS file page of this dialog box to import data from the FFS file (has the extension csv) to 
the Measurements Database. The correspondent raw data (has the extension FFS) can be also 
imported through Raw data file page of this dialog box (actually a link to the file is stored). One 
can link many raw data files to one record in the Raw Data table when necessary. Especially it is 
useful when these raw data files represents a series of repetitions of the measurement with the 
same conditions. It reduces the number of stored records and allows calculating of statistical 
characteristics in Data Builder from each repetition just by clicking one button. 
Uncheck the Import FFS file check box if you want to import raw data file only.   
An example view of the dialog box is given below: 



 
To find out more about the functionality of any component, click this component in the figure.  

Raw data page 
An example view of the dialog box is given below: 

 
To find out more about the functionality of any component, click this component in the figure.  
  
Import SPC files dialog box 
Use the dialog box to import raw data to the Measurements Database (actually a link to the file is 
stored). If the raw data represented by a series of files (differ by only its number) select all of 
them. They will be processed as single one. One can link many raw data to one record in the 
Raw Data table when necessary. Especially it is useful when these raw data files represents a 
series of repetitions of the measurement with the same conditions. It reduces the number of 



stored records and allows calculating of statistical characteristics in Data Builder from each 
repetition just by clicking one button. 
 
An example view of the dialog box is given below: 

 
To find out more about the functionality of any component, click this component in the figure.  
 

Observat table 
Is used to store information about the measurements (usually imported from FFS files. Several 
records from the Observat table are related to one record in the DataSets table (relationship 
"many-to-one").  
It is used also for storing the statistical characteristics derived from the raw data.   
Field name  Type  Description 

ObservationID Autoincrement  Identifies of the record  

FileName  String  Name of the file 

DataSetID  Numeric  Identifier of the record in DataSets table. Needs the relation 
to the DataSets table to be established. 

Type  String  Type of data 

NumChannels  Numeric  Number of Channels 

SamplePos  String  Position of the sample (parameter of equipment) 

KineticNumber  Numeric  Kinetic number 

RepeatNumber  Numeric  Repeat number 

SamplePosX  Numeric  X position of sample (parameter of equipment) 

SamplePosY  Numeric  Y position of sample (parameter of equipment) 



Duration  Numeric  Duration (parameter of equipment) 

TimeStep  Time  Time step. It is calculated from the imported data in case of 
measured data.  

Range  String  Left and right positions of raw data markers (only for raw 
data derived statistical characteristics) 

StartTime  Time  Start Time (parameter of equipment) 

IsRawDataDerived  Logical  Defines the source of data. It is true when statistical 
characteristics were calculated from the raw data 

IsWeight  Logical  Defines the existence of the weight. It is true if the weight 
factors were calculated 

CorrData  Memo  Contains measured or calculated data 

Weight  Memo  Contains weight data 

Notes 
" Field ObservationID is read only. 
" This table can be sorted by any field (except CorrData and Weight). To perform the sorting by 
the given field, select this field and press Ascending/Descending Sort button in the Toolbar or 
choose Ascending/Descending menu items in the local menu. 
" Use Quick Search button in the Toolbar or choose Quick Search menu items in local menu for 
quick searching the information in the selected field.  
 

DataSets table 
Is used to store information related to one group of files. Several records from the DataSets table 
are related to one record in the Guests table and to one record in Samples table (relationship 
"many-to-one").    
Field name  Type  Description 

DataSetID Autoincrement  Identifies of the record.  

Name  String  Name of the files group 

GuestID  Numeric  Identifier of the records in Guests table. Needs the relation to the 
Guests table to be established. 

SampleID  Numeric  Identifier of the records in Sample table. Needs the relation to the 
Sample table to be established. 

ObservDate  Date/Time  Date of measurements 

Description  Memo  Description of the file group 

Notes 
" Field DataSetID is read only. 
" This table can be sorted by any field (except Description). To perform the sorting by the given 
field, select this field and press Ascending/Descending Sort button in the Toolbar or choose 
Ascending/Descending menu items in the local menu. 
" Use Quick Search button in the Toolbar or choose Quick Search menu items in local menu for 
quick searching the information in the selected field.  
 

Guests table 
Contains information about person or organization who orders measurements.   



Field name  Type  Description 

GuestID  Autoincrement  Identifies of the record  

Guest  String  Name of the person or organization who orders measurements 

Address  String  Address 

Organization  String  Organization 

Tel  String  Telephone 

Fax  String  Fax 

Notes 
" Field GuestID is read only. 
" This table can be sorted by any field. To perform the sorting by the given field, select this 
field and press Ascending/Descending Sort button in the Toolbar or choose 
Ascending/Descending menu items in the local menu 
" Use Quick Search button in the Toolbar or choose Quick Search menu items in local menu for 
quick searching the information in the selected field.  
 

Samples table 
Contains the detailed information regarding the explored sample.   
Field name  Type  Description 

SampleID  Autoincrement  Identifies of the record  

Sample  String  Name of the sample 

Description  Memo  Description of the sample 

Notes 
" Field SampleID is read only. 
" This table can be sorted by any field (except Description). To perform the sorting by the given 
field, select this field and press Ascending/Descending Sort button in the Toolbar or choose 
Ascending/Descending menu items in the local menu. 
" Use Quick Search button in the Toolbar or choose Quick Search menu items in local menu for 
quick searching the information in the selected field.  
 

Parameters table 
Is used to store the equipment parameters. Several records from the Parameters table are related 
to one record in the DataSets table (relationship "many-to-one").    
Field name  Type  Description 

ParameterID Autoincrement  Identifies of the record  

DataSetID  Numeric  Identifier of the record in DataSets table. Needs the relation to the 
DataSets table to be established 

Name  String  Name of the parameter 

Value  String  Value of the parameter 

Notes 
" Field ParameterID is read only. 
" This table can be sorted by any field. To perform the sorting by the given field, select this 
field and press Ascending/Descending Sort button in the Toolbar or choose 
Ascending/Descending menu items in the local menu. 



" Use Quick Search button in the Toolbar or choose Quick Search menu items in local menu for 
quick searching the information in the selected field. 
 

External parameters table 
Is used to store the external parameters. These parameters are used for displaying dependence of 
estimated parameters (Estimated parameter versus External parameter). Several records from the 
External parameters table are related to one record in the DataSets table (relationship "many-to-
one"). While entering the parameter it is necessary to add the parameter name to the PNames 
table.   
Field name  Type  Description 

ParameterID Autoincrement  Identifies of the record  

DataSetID  Numeric  Identifier of the record in DataSets table. Needs the relation to the 
DataSets table to be established 

Name  String  Name of the parameter 

Value  String  Value of the parameter 

Notes 
" Field ParameterID is read only. 
" Field Name is the lookup field. It lookups the information from the PNames table. 
" This table can be sorted by any field. To perform the sorting by the given field, select this 
field and press Ascending/Descending Sort button in the Toolbar or choose 
Ascending/Descending menu items in the local menu. 
" Use Quick Search button in the Toolbar or choose Quick Search menu items in local menu for 
quick searching the information in the selected field. 
 

PNames table 
Is used to store the external parameter names. It is created in order to avoid mistakes while 
entering external parameter names. At the beginning it is necessary to add the parameter name to 
the PNames table then this parameters can be chosen from drop-down list in the External 
parameters page of the Parameters panel. 
   
Field name  Type  Description 

Name  String  Name of the parameter 

Notes 
" Field ParameterID is read only. 
" This table can be sorted by any field. To perform the sorting by the given field, select this 
field and press Ascending/Descending Sort button in the Toolbar or choose 
Ascending/Descending menu items in the local menu. 
" Use Quick Search button in the Toolbar or choose Quick Search menu items in local menu for 
quick searching the information in the selected field. 
 
RawData table 
Contains link to the raw data file(s) and some other information. Each record in the Raw Data 
file is linked to the correspondent record in the Data Sets table (that is automatically created 
during the import of raw data file). One can link many raw data files to one record in the Raw 
Data table when necessary. Especially it is useful when these raw data files represents a series of 
repetitions of the measurement with the same conditions. It reduces the number of records in the 



table and allows calculating of statistical characteristics from each repetition just by clicking one 
button. The Files Count field represents the number of files linked to the current record.     
Field name  Type  Description 

ID Autoincrement  Identifier of the record  

File name  String  Name of the file 

File path  String  Path to the first source file 

File path 
extension  String 

 Path to the others source files. If a number of files are linked 
to the record, this field contains the path to all files except the 
first one  

Type  String  Data format 

Group ID  Numeric  Contains ID of the record in the DataSets table that is linked 
to current record. 

Date  Date  Date of the record creation  

Red Channel 
Count  Numeric  Events count in the red channel raw data time trace 

Blue Channel 
Count  Numeric  Events count in the blue channel raw data time trace 

End Time  Numeric  Measurements time 

Clock Time  Numeric  Clock cycle (run length encoding) 

Description  Memo  Description of the raw data  

Notes 
" Field ID is read only. 
" Field Files Count shows the number of raw data files linked to the record. 
" This table can be sorted by any field (except Description). To perform the sorting by the given 
field, select this field and choose Ascending/Descending menu items in the local menu. 
" Choose Quick Search menu items in local menu for quick searching the information in the 
selected field.  
 
An alias is a name and a set of parameters that describe a database resource. BDE applications 
use aliases to connect with databases.  
 
FCS file contains statistical characteristics like as auto(cross)correlation, photon counting 
histogram, etc., already calculated by data acquisition card.  
 
Raw data files contains photon arrival times or time lags between consecutive photons. Usually 
stored in binary file in FIFO mode accordingly special dataformat.  
  
Supported file formats 
FFS Measurements database can import data from text files having several data format. 
Supported data formats are: 
1. Two column data without a caption. Values inside one row can be separated by a number of 
spaces or tabs. The first column must contain X values, the second Y values. Time has to be in 
milliseconds for AC(C)F. 
2. Three column data without a caption. Values inside one row can be separated by a number of 
spaces or tabs.  The first column must contain X values, the second Y values, the third - weight 
factors (standard deviations of each Y). Time has to be in milliseconds for AC(C)F. 



3. specially formatted files having either SSTC_2Column_data_with_params or 
SSTC_3Column_data_with_params. 
  
SSTC_3Column_data_with_params data format  
File structure: 
File must begin from the line #Version=... 
Parameters section comes directly after this line. 
The data section follows parameters section and must begin from the line #Data 
 
#Version=SSTC_3Column_data_with_params 
#Type=Autocorrelation (or Crosscorrelation; PCD; FFC) 
#Channel=red (or blue) 
#SamplePosition=any text up to 30 symbols 
#SamplePositionX=any double precision value  
#SamplePositionY=any double precision value 
#KineticNumber=any integer value  
#RepeatNumber=any integer value 
#Range=any text up to 60 symbols 
#Duration=any double precision value 
#Normalization=integer value. It must be 1 for ACF, CCF, FFC, and be equal to either 1 or to 
number of processed bins in the intensity for PCD (preferably), i.e. be equal to sum of all bin 
heights in the histogram. It is assigned to 1 if it is not supplied. 
 
#Data 
X Y W 
0.0002 2.0197656 1.4335435  
0.0004 1.8976443 1.3324353 
... 
  
General comments: 
Parameters will be imported only if the #Version equal to ‘SSTC_2Column_data_with_params’ 
or ‘SSTC_3Column_data_with_params’. See below available parameter names and data types. 
No spaces must surround ‘=’ sign.  
If no parameters are supplied the type is considered to be ‘Autocorrelation’  
 
Data section must contain tab or space delimited values. Number of columns in the Data section 
must be three: 
1 column – X (time in milliseconds for AC(C)F) 
2 column – Y (do not round values) 
3 column – weight (it can be equal to Y (Poisson statistics), 1 (no weight), or be properly 
calculated). Do not put zeros in this column. A point with zero weight does not participate in the 
analysis. 
 
Note: Algorithm can also read two channel data (without weight). It is equivalent to setting 
#Version to SSTC_2Column_data_with_params. 
  
Example: 
#Version=SSTC_3Column_data_with_params 
#Type=Autocorrelation 
#Channel=red 
#SamplePosition=E5/C3 
#SamplePositionX=300  



#SamplePositionY=150 
#KineticNumber=1 
#RepeatNumber=5 
#Range=[20 60] 
#Duration=40 
 
#Data 
X Y W 
0.0002 2.0197656 1.4335435  
0.0004 1.8976443 1.3324353 
... 


